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Learning Outcomes 

Upon successful completion of this course students will be able to: 

 

 Plan, create, modify, and present spreadsheets 

 Organize, edit and enhance data in spreadsheets to achieve business 
standards 

 Use formulas and built-in functions appropriately and correctly to solve 
problems and critically assess the results 

 Design efficient spreadsheets capable of answering "what-if" questions to 
solve business problems 

 Plan, organize, create and present spreadsheet data in graphic form 

 Plan, create and present a custom Excel application using complex 
functions and macros 

 Use built-in financial, logical, and lookup functions appropriately and 
correctly to solve problems and critically assess the results 

 
 

Topics 

 Principles of electronic spreadsheets using features available with currently 
popular spreadsheet software:  

 Worksheet creation and formatting;  

 entering of data 

 editing and printing 

 formulas    

 functions  

- Logical functions 

- Math  and trig functions 

- Statistical functions 

- Lookup and reference functions 

- Text functions 

- date and time functions 
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 basic charting 

 Advanced Tools 

- Conditional format  

- Tables 

- Data validation 

- pivot tables 

 
 
 
 

Textbook 

 Microsoft Excel 2010: Comprehensive By: Gary B. Shelly, Jeffrey J. Quasney, 
Steven M. Freund, Raymond E. Enger, and Mali B. Jones. 2012 Course 
Technology, Cengage Learning . 

 Excel 2007 for project managers : Comprehensive By: Kim Heldman 
,William Heldman   , Wiley Publishing, Inc.,2007 . 

 

 Excel® 2010 Formulas: Comprehensive By:  John Walkenbach , Published 
by Wiley Publishing, Inc., Indianapolis, Indiana,2010 
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 What is Excel? 
Software developed and manufactured by Microsoft Corporation that  allows  users to 

organize , format , and calculate data with formulas  using a spreadsheet system broken up by 
rows  and columns . 

 Microsoft Excel usually comes bundled with Microsoft Office and is compatible with 
other applications offered in the suite of products. The first software program similar to Excel was 
released in 1982 and was called Multiplan. 

 

 Principles of electronic spreadsheets . 
 As we sow in the following figure excel files named as  book1, book2 ,…   and so on .  

 Every workbook contains from numbers of rows that  intersection with numbers of 
columns which gives the cells that  represent the sheet. 

 Every workbook have three sheet at first and you can expended it to255 sheets by Press 
shift +f11 or click insert worksheet button. 

 Every sheet have  256 columns and 65536 rows , 

 Then every  workbook file have(cells) = 256 columns,  

 That mean  65536 * 255   cell in each sheet. 

 

 

 

 

 

 

 

  

Title Bar 
Menu Bar Tool bar 

Active cell 

Name box 

Office button 

Quick Access 

rows 

Document  area 

Formula Bar 

Insert worksheet 

Tab worksheet 

zoom 

Page layout style 

column 

Ribbon bar 

http://www.businessdictionary.com/definition/bundle.html
http://www.businessdictionary.com/definition/Microsoft-Office.html
http://www.businessdictionary.com/definition/application.html
http://www.businessdictionary.com/definition/product.html
http://www.businessdictionary.com/definition/program.html
http://www.businessdictionary.com/definition/call.html
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 Press Enter button to move cross the column and Press Tap button to move cross the Row .  

 Press Alt +Enter  to  write multiple line in same cell. 

 As default menu bar contain seven submenu (Home , Insert, Page layout, Formulas ,Data , 
Review and View ). 

 We can expended the menu bar sub menu by adding new submenu like ( Developer , load 
test and Team ) , which use in macro programming and many of advanced tool by click to 

 

Office button  Excel Options  click  Show Developer in The ribbon under Top options 

for working with Excel title . 

 

 

 

 

 

 

 

 

 

 

 
 In Excel options window we can change the most popular  options in Excel  as shown in the 

figure above. 

Note: We will give brief information for every items in menu bar , the extended information 
we will talking  about in the course Lab. 

 

 Office button :  this submenu deal with the operation with books file like  , new , open , save , 

save as , and so on as shown in the  next figure . 
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 Home: This submenu deals with basic sheet options like  (clipboard ,font ,alignment , number 
,style ,cells and editing )  as shown in the next figure.  

 

  

  

  

  
 Insert : This submenu deals with basic  object that we can inserted inside the sheet like (Pages , 

Tables , Illustrations ,Links , Header & Footer , Text and Symbols )  as shown in the next 
figure. 

 

 

 

 

 

 
 Page Layout: This submenu deals with  layout options of sheet like (Themes , Page Setup, Scale 

to Fit , Sheet Options and Selection Pane and Align) , as shown in figure above .   

 

 

 

 

 Formulas : This submenu deals with formulas options and types   that we can used in sheet like 
(insert function , function Library , Defined Names , Formula Auditing  and Calculation) , as 
shown in figure  bellow.  

 

 Data: This submenu deals with sheet Data options ,sources ,operation and tool like (Get External 

Data , Connections , Sort & Filter , Data Tools and Outline ), as shown in figure  bellow.       

 
  
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 Review: This submenu deals with the basic sheet review like (Proofing , Comments and 
Changes ), as shown in  figure  bellow.       

  

 View: This submenu deals with the options  of  workbook view like (Workbook Views , 
Show/Hide , Zoom , Window and Macros) , as shown in  figure  bellow.        

 

 

 

 

 

 
 Developer: This submenu its added to the menu bar when  needed to work with advanced tools 

like  (Code , Controls , XML and Modify ) , as shown in  figure  bellow. 

 

 

 

 

 

 Load test: This submenu deals with sheet load test options like Report  , as shown in  figure  

bellow. 

 

 

 

 

 
 Team: This submenu deals with sheet Team option like (Work item , Tree , new  

Report and help ) , as shown in  figure  bellow. 
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 Worksheet creation and formatting. 
 General Guidelines 

While creating an Excel worksheet, you need to make several decisions that will determine 
the appearance and characteristics of the finished worksheet. As you create the worksheet you 
should follow these general guidelines:  
1. Select titles and subtitles for the worksheet.  
2. Determine the contents for rows and columns.  
3. Determine the calculations that are needed.  
4. Determine where to save the workbook.  
5. Identify how to format various elements of the worksheet.  
6. Decide on the type of chart needed.  
7. Establish where to position and how to format the chart.  
8. Choose a name for the worksheet.  
9. Determine the best method for distributing the workbook.  
 

 Worksheet creation 
We can create new worksheet  by click office button  new  ,will open new worksheet . 

 

 Worksheet formatting  
we can change  cell format by tools in home submenu   or sheet format in page Layout   

submenu. 

 

 Entering of data. 
we can entering data in the sheet by select the cell or the range of cells that you wont to 

entering data in it , we can use  Enter button to move over sheet column or press TAP button to 
move cross sheet Rows .  

 

 Cells proprietress 
 The cell it’s the building unit of excel  sheets  m each sheet contain 65536 * 255    cell . 
 Each cell may have one of the Eleven data type that supported by excel  , the General data 

type it’s the default data type for each cell .  
 



Computer Application in Business-2019 Dr.Aliea Salman 
 

9  

 

Data types Description 

 

 The cell in this data type my hold  numbers values or text values  
Exp:  565   or   Ali 

 

The cell in this data type hole  numbers values only  
Exp:12 or 12.454 

 

The cell in this data type  hold currency number values   
Note : the currency sign like  $ ,  د.ع  or  €   inserted automatically when 
change the cell data type to currency, do not typed it  manually , that 
cause change the cell data type to text , that mean you just enter the 
number value the sign appear in the cell automatically  
 
Exp : 23 $  , 12.444 د.ع 

 

The cell in this data type  hold accounting number values  
 
Exp:  123.444 $  

 

The cell in this data type  hold short data values  
 
Exp : 23/2/2019 

 
The cell in this data type  hold long data values  
 
Exp:  23/02/2019 22:11 pm 

 

The cell in this data type  hold time values  
 
Exp : 10:12 PM 

 

The cell in this data type  hold percentage  values  
 
Note: don’t type the % sign in cell , the sign inserted automatically if 
you change the cell data type to percentage type  
 
Exp: when  we type the value 0.5 in cell percentage data type 

automatically  changed to 50.0% value in the same cell . 

 

The cell in this data type  hold number in fraction   format 
 
Exp : when  enter value have fraction part like  
12.5 converted to 12 ½        or                     23.6   converted to   23 3/5 

 

The cell in this data type  hold scientific number values  
Exp: 2.00E+00 

 
The cell in this data type  hold text values  
Exp: Zain Hazeim  

 The cell in this data type  hold custom user define data  
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 Absolute Cell Reference  
Absolute cell references can be very important when copying and pasting formulas.  By 

default, when    you copy and paste a formula it will use a relative cell reference.  When the 
formula is pasted it will automatically change to a cell range, within the range of where the 
formula is being pasted.  In some cases that is fine, but not when you want to reference the same 
cell range in the original formula.   

 
Absolute cell references need to be used if you want to reference the same cell in a copied 

formula.  To reference an absolute cell put a dollar sign ($) in front of the reference that should 
be absolute.  Cell references can be a mix of absolute and relative.  Example of cell reference 
combinations, using cell C2:  

 
1. $C$2 – This is an example of an absolute cell reference that would always reference the value in cell 

C2.  
2. $C2 – This is an example using absolute and relative cell references.  This cell reference would always 

reference column C, but the cell row would change.  
3. C$2 – This is an example using absolute and relative cell references. This cell reference would always 

reference row 2, but the column would change.  
4. C2 – This is an example of a relative cell reference that would change when the formula is copied.  The 

cells would change in reference to where the formula is pasted. 
 

Note:  The F4 key can be used to toggle between the cell reference options, or the dollar sign can be 
typed in front of the cells that should be absolute cell references.  To use the F4 option, click in the 
formula next to the cell reference and push the F4 key to toggle through the above cell reference options. 

 

      Absolute Cell Reference  Example  
Example -1 :Convert currency 

In a worksheet, currency has to be converted from dollars (column B) to euros (column C). 
The rate of exchange from dollars to euros is placed in cell C1; here we use 0.8021. 

To convert currency: 
1. In a worksheet, enter your own data or the data 

shown in next Figure . 
2. Select cells C4:C8. 
3. Enter the following formula: =B4*$C$1. 
4. Press <Ctrl+Enter>. 
5. From the Format menu, select Cells. 
6. Select the Number tab and then select 

Currency from the Category list. 
7 . Choose Euro. 
8. Click OK  

 
 Note: To convert euros back to dollars, use the following formula: =C4/$C$1. 
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Example-2 : Calculate a price reduction 
All prices in a price list have to be reduced by a certain percentage. The amount of the price 

reduction is 15% and is entered in cell  To reduce all prices by a certain percentage: 

1. In a worksheet, enter your own data or the data 
shown in the next Figure 
2. Select cell C1 and type -15%. 
3. Select cells C4:C8. 
4. Enter the following formula: =B4+(B4*$C$1). 
5. Press <Ctrl+Enter>. 
 

 

 
Note: Please note that the formula must have an absolute reference to cell  C1. Also, columns B and C are 
formatted with the Currency style, which is available by clicking on the $ button on the Formatting 

toolbar. 

 

 
 Naming a Cell or Range of Cells 

A named cell or range of cells can be used in formula references.  Naming a cell or range of 
cells is a good time saver when writing formulas that are calculating between multiple sheets. 
Named cells or ranges can also be used in place of absolute cell references. 

 
1. Select the cell or range of cells to be named  
2. To the left of the formula bar is the name box, as shown in the picture to the right.  By default, the 
name box will reference a cell that is selected.  
4. Type in a name for the selected cell or range of cells 
5. Press the enter key  

 
 

 
 
 
 

Note:  If a cell or range of cells has been named, the cell or range will need to be selected for the name to 
appear in the name box. 
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 Using Names in Formulas  
  Names can be used in formulas by referencing the name instead of the cell reference.  For 

example:  I want to use a formula that figures a discount of 5%.  Cell B4 has the value of 5%.  I have 
named the cell “Five”.   

If I wanted to multiple a cell by the value in B4 (5%), I can simply reference the cell name no 
matter where I am in the workbook.  

 
Example of formula with cell name:  = G8*Five, this would take  the value in cell G8 and multiply it 
by the cell named “Five”, which is 5%. 

  

Note:  When using more advanced formulas it is much easier to reference a named cell or range of 
cells than having to select a whole table. 

 
 
 

 
 
 
 
 
 

 Finding a Named Cell or Range  
By using the name box it is easy to find a named cell or range of cells.  

1. Click the drop-down arrow next to the name box 
     Note:  The name box will reference the cell that is currently selected.  
2. The drop-down menu will show a list of named cells or ranges 
3. Select the name.  The cursor will select that cell or range of cells  

 
 
 
 

 Editing a Named Cell or Range  
A named cell or range of cells can be changed by using the name manager.  
 
1. Select the formulas tab 
2. Under the defined names group, select the name manager button 
3. Select the name to be changed 
4. Click the edit button to change the name or cell range  



Computer Application in Business-2019 Dr.Aliea Salman 
 

13  

 

          Note:  A new named range can also be created by using the New…button in the name manager 
window.  The filter button can be used to search specific areas for defined names.  

           
         5. Click close when finished with the name manager dialog box 

 

 
 
 
 

 
 
 
    Using Name in Formulas examples  

 
Example-1 :Calculate taxes 

           In this exercise, tax on an item has to be calculated. We can also find the original price 
given the tax rate and the final price by using names. 

 
To calculate the price with tax: 
1. Select cell A2 and type 8%  and type tax_1 in name box 
then press <Enter> . 
2. Select cell B2 and type 120 and type net_1 in name box 
then press <Enter> . 
3. Select cell C2 and type the following formula: 
=net_1+net_1*tax_1. 
 
To calculate the original price: 

1. Select cell A4 and type 8% tax_2 in name box then 
press <Enter> . 

2. Select cell C4 and type 129.60 gross_2 in name box 
then press <Enter> .. 

 3. Select cell B4 and type the following formula: 
=gross_2/(1+tax_2). 
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 Formulas 

 Formula Structure  

 To write complex formulas you will need to know basic formula structure.  There are 
multiple ways to write formulas.  Choose the best one that fits your needs for each scenario.  

 

 Formulas are made up of three basic parts, the equals sign, a function or operator, and 
arguments. There are two main ways to write Excel formulas, with an operator or with a 
function.  Functions can beused as a short cut to create commonly used formulas.  

 

 Lastly are the arguments.  Arguments are the numbers or cell references that will be used to 
figure a formula.  

 Example using operator: = B1+B2+B3+B4+B5+B6+B7.  The operator in this formula is 
the + sign.  

 Example using function:  =SUM(B1:B7).  The function in this formula is SUM (which is for 
adding values).  

 Formulas using functions have a different format than formulas using operators.  

  Formulas that use function also start with an equals sign, but instead of a mixture of 
arguments and operators, the function is entered right after the equal sign with the arguments 
following in parentheses. 

 

 How to write a formula using a function 
 

1- Individual Arguments 
Individual arguments can be used to reference specific cells within a spreadsheet.    Commas 

can be used to separate individual arguments. Example 
 

                                                          = Function (Argument1; Argument 3)    
         

2- Through Arguments 
    A colon can be used to reference arguments that are in consecutive order.  

Example  
= Function(Argument 1:Argument 3). 

 
 

 Calculating Across Worksheets  
Calculating across worksheets will allow you to pull values from multiple worksheets to create a 

desired formula.  When calculating across worksheets you will need to reference sheet names.   
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The symbol to reference a sheet is an exclamation point (!). The exclamation point will need to be 
added to the end of the sheet name.  

 
 

 Referencing Multiple Worksheets  
When referencing a different sheet than the one the formula will appear on, the formula will need to 

include an exclamation point after the sheet name.  For example I have a worksheet with the name 
Library, to reference that sheet name I would type Library! Within the parenthesis of the argument area.  
The cell reference will follow the sheet name.  

 
 Sheet Separators  
If you will be referencing sheets that are in a consecutive row, use the symbol for through, which is a 

colon (:).  
 
If you will be referencing only specific sheets use a comma(, or ; ) between the sheet names.  

 
 

 3-D Cell References  
Three-dimensional cell references are used when referencing the same cell across multiple 

worksheets. An example of a 3-dimentional reference is shown below. 

  

  Using formulas for sheets in consecutive order: 
The example below shows how to create a formula with consecutive worksheets.  

=SUM(Library:Reeve!B9) 
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 How Can I Create Named Ranges? 
There are three ways to create named ranges:   

 

1- Using the Name Box to Create a Range Name 
   In previous sections we explain the methods of give name to  single cell. Now: Suppose you 

want to assign a rectangular range of cells (such as A1:B4) the name Data. Simply select the cell 
range A1:B4, type Data in the Name box, and press Enter. Now a  formula such as 
=AVERAGE(Data) would average the contents of cells A1:B4.  As shown in the next figure . 

 
 
 
 
 
 
 
 

 

    Note1 :Sometimes you want to name a range of cells made up of several noncontiguous  
rectangular ranges. For example, in the next Figure  we might want to assign the name 
Noncontig to the range consisting of cells B3:C4, E6:G7,  and B10:C10. To assign this 
name, select any one of the three rectangles making up the range (I chose B3:C4).  Hold 
down the Ctrl key, and then select the other two ranges (E6:G7 and B10:C10). 

 
Now release the Ctrl key, type the name Noncontig in the Name box, and press Enter. Using 

Noncontig  in any formula will now refer to the contents of cells B3:C4, E6:G7, and B10:C10. For example, 
entering the formula =AVERAGE(Noncontig) in cell E10 yields 4.75 (because the 12 numbers in our range 
add up to 57 and 57/12=4.75). 
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2- Creating Named Ranges by Using the Create From Selection 
Option 

The worksheet in the next figure  contains sales during March for each of the 50 U. S. states.  
Figure 2-1 show   a subset of this data. We would like to name each cell in the range B6:B55 with 
the correct state abbreviation. To do this, select the range A6:B55, and click Create From Selection 

in the Defined Names group on the Formulas tab (see Figure 2-2). Then select the Left Column 
check box, as indicated in Figure 2-3. 

 
 
 
 
 

 
 

FIGURE 2-1 By naming the cells that contain state sales with state abbreviations, you can use the abbreviation rather than the cell’s column letter and 
row number when you refer to the cell. 

  

FIGURE 2-2 Select Create From Selection. 
 

FIGURE 2-3 Select the Left Column check box 
 

 

3- Creating Range Names by Using the Name Manager Option 
              If you click Name Manager on the Formulas tab and then choose New, the New Name  dialog box   
            shown in Figure 2-4 opens. 

 
 
 
 
 
 
 
 
 
 
 

 
FIGURE 2-4 The New Name dialog box before creating any range names. 

 

If you click the Scope arrow, you can select the option Workbook or any worksheet in your 
workbook. I’ll discuss this decision later, so for now just choose the default scope of Workbook. You 
can also add comments for any of your range names. 
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 A Name’s Scope 
 it’s important to understand that all names have a scope. A name’s scope defines where you 

can use the name. Names are scoped at either of two levels: 
 

 Workbook-level names: Can be used in any worksheet. This is the , default type of 
range name . like = sale1 , where sale1 cell name. 

 Worksheet-level names: Can be used only in the worksheet in which they are 
defined, unless they are preceded with the worksheet’s name. A workbook may 
contain multiple worksheet-level names that are identical.  like , sheet1!sale1 . 

 
Note1: If your worksheet name contains a space, enclose the worksheet name in single quotes 

when referring to a name defined on that sheet: 
             =’My Sheet’!My_Name  

 
 
Note2: Only the worksheet-level names on the current sheet appear in the Name box. 

Similarly, only worksheet-level names on the current sheet appear in the list under 
Formulas➜ Defined Names➜Use in Formulas. 

 
 

 Referencing names from another workbook 

 The same rules apply when using names defined in another workbook. 
 

Note1: For example, the following formula uses a range named MonthlySales, defined in a 
workbook named Budget.xlsx (which is assumed to be open): 
=AVERAGE(Budget.xlsx!MonthlySales) 
 
Note2: If the name MonthlySales is a worksheet-level name on Sheet1, the formula looks 
like this: =AVERAGE([Budget.xlsx]Sheet1!MonthlySales) 

 
 

Calculating Across Worksheets  Examples  
Example -1:   find total summation Across consecutive orders 
 Assume you enter the data of three student in three different courses in three consecutive 

sheet in the same worksheet (course1, course2, course3) as showen in the following figures. 
 



Computer Application in Business-2019 Dr.Aliea Salman 
 

19  

 

 

  

Course1-sheet Course2-sheet 

 
Course3-sheet 

 
To calculate the total sum in 

total sheet : 
1- Select cells c2:c4 and type the 

formula 
:=sum(course1:course3!c2) 

2- Press <Ctrl +Enter> 
 

 

 

 Rules for naming names  
we can samurais the rules for naming names as follows :  

 Excel does not allow you to use the letters r and c as range names. 
 If you use Create From Selection to create a range name and your name contains spaces, 
Excel inserts an underscore ( _) to fill in the spaces. For example, the name Product 1 is 
created as Product_1. 

 Range names cannot begin with numbers or look like a cell reference. For example, 3Q and 
A4 are not allowed as range names. Because Excel 2010 has over 16,000 columns, 

 a range name such as cat1 is not permitted because there is a cell CAT1. If you try and 
name a cell CAT1, Excel tells you the name is invalid. Probably your best alternative is to 
name the cell cat1_. 

 The only symbols allowed in range names are periods (.) and underscores ( _). 
 

 Functions  
  What Is a Function? 

A worksheet function is a built-in tool that you use in a formula. Worksheet functions allow 
you to perform calculations or operations that would otherwise be impossible. You’ll find 
functions useful because they 

 Simplify your formulas 
 Permit formulas to perform otherwise impossible calculations 
 Speed up some editing tasks 
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 Allow conditional execution of formulas — giving them rudimentary     decision-
making  capability 

 

 Function Argument Types 
. The information within the parentheses is the function’s arguments. Functions vary in how they 

use arguments. A function may use 

 No arguments 

 One argument 

 A fixed number of arguments 

 An indeterminate number of arguments 

 Optional arguments 
 Names as arguments 

To calculate the sum of the values in A1:A20, you\ can use , =SUM(A1:A20) , And, not 
surprisingly, if you’ve defined a name for A1:A20 (such as Sales), you can use the name in place of 
the reference:  =SUM(Sales) 

 

 Full-column or full-row as arguments 
  For example, the following formula sums all values in column B: =SUM(B:B) Using full-column and 
full-row references is particularly useful if the range that you’re summing changes. If you do use an 
entire row or column, just make sure that the row or column doesn’t contain extraneous 
information that you don’t want to include in the sum. 

 

 Literal values as arguments 
A literal argument refers to a value or text string that you enter directly. For example, the 

SQRT function, which calculates the square root of a number, takes one argument. In the following 
example, the formula uses a literal value for the function’s argument:    =SQRT(225) 

 
Using a literal argument with a simple function like this one usually defeats the purpose of 

using a formula. This formula always returns the same value, so you could just as easily replace it 
with the value 15. You may want to make an exception to this rule in the interest of clarity. For 
example, you may want to make it perfectly clear that you are computing the square root of 225 

 
Using literal arguments makes more sense with formulas that use more than one argument. 

For example, the LEFT function (which takes two arguments) returns characters from the beginning 
of its first argument; the second argument specifies the number of characters. If cell A1 contains the 
text Budget, the following formula returns the first letter, or B: =LEFT(A1,1) 

 
 Expressions as arguments 

Excel also enables you to use expressions as arguments. Think of an expression as a formula 
within a formula (but without the leading equal sign). When Excel encounters an expression as a 
function’s argument, it evaluates the expression and then uses the result as the argument’s value. 
Here’s an example: 
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=SQRT((A1^2)+(A2^2)) 
This formula uses the SQRT function, and its single argument appears as the following 

expression:   (A1^2)+(A2^2) 
 

Note: When Excel evaluates the formula, it first evaluates the expression in the argument and then 
computes the square root of the result. 

 

 Other functions as arguments 
Because Excel can evaluate expressions as arguments, it shouldn’t surprise you that these 

expressions can include other functions. Writing formulas that have functions within functions is 
sometimes known as nesting functions.  

Excel starts by evaluating the most deeply nested expression and works its way out. Note 
this example of a nested function:  =SIN(RADIANS(B9)) 

 

 Arrays as arguments 

 A function can also use an array as an argument. An array is a series of values separated 
by a comma and enclosed in brackets. The formula below uses the OR function with an array as 
an argument. The formula returns TRUE if cell A1 contains 1, 3, or 5.       =OR(A1={1,3,5}) 

 

 Ways to Enter a Function into a Formula 
       You can enter a function into a formula by typing it manually, by using the Function Library 

commands, or by using the Insert Function dialog box. 

1- Entering a function manually 

If you’re familiar with a particular function — you know its correct spelling and the types of 
arguments that it takes — you may choose to simply type the function and its arguments into your 
formula. Often, this method is the most efficient. As shown in the next figure  

 
  

 

 
 
 
 
 
 

 
2- Using the Fun ction Library commands 

Another way to insert a function into a formula is to use the icons in the Formulas ➜ Function Library 

group. The next Figure shows these icons, each of which is a drop-down control. 
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3- Using the Insert Function dialog box 

To insert a function, select the function from the Insert Function dialog box, as shown in the next 
Figure. You access this dialog box by Choosing 

 
 Formulas ➜Function 

 Library➜Insert Function Choosing 

 Formulas➜Function Library➜AutoSum,  and then clicking More Functions in 
the  drop-down list 

 Clicking the fx icon to the left of the Formula bar 

 Pressing Shift+F3 

   

 

 

 

 
  

 

Figure: The Insert Function dialog box. 
 
When you locate the function that you want to use, click OK. Excel’s Function Arguments 

dialog box appears, as shown in  the next Figure. Use the Function Arguments dialog box to specify 

the arguments for the function.  
 
You can easily specify a range argument by clicking the Collapse Dialog button (the icon at the 

right edge of each argument field). Excel temporarily collapses the Function  Arguments dialog box 
to a thin box, so that you can select a range in the worksheet. 
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Figure : The Function Arguments dialog box. 
 

 Editing and printing 
 Formatting the Worksheet 

Although the worksheet contains the appropriate data, formulas, and functions, the text 
and numbers need to be formatted to improve their appearance and readability.  a worksheet 
that is formatted not only is easier to read but also looks more professional. By formatting the 
contents of the worksheet, you can improve its overall appearance. When formatting a 
worksheet, consider the following formatting suggestions: 

 

 Increase the font size of cells 
 Change the font color of cells 
 Center the worksheet titles, subtitles, and column headings 

 Modify column widths to best fit text in cells 
 Change the font style of cells. 

 
 
 

 Checking Spelling 
 Excel includes a spell checker  in  Review Submenu you can use to 

check a worksheet for spelling errors.  

 

 Preparing to Print the Worksheet 
 Excel allows for a great deal of customization in how a worksheet appears when printed. 

For example, the margins on the page can be adjusted. A header or footer can be added 
to each printed page as well. 

 Excel also has the capability to work on the worksheet in Page Layout view. 
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 Page Layout view allows you to create or modify a worksheet while viewing how it will 
look in printed format. 

 The default view that you have worked in up until this point in the book is called Normal 
view. 

 

Tips: Specify how the printed worksheet should appear. 
 
 Before printing a worksheet, you should consider how the worksheet will appear 

when printed.  

 In order to fit as much information on the printed page as possible, the margins 

 of the worksheet should be set to a reasonably small width and height.  

 While the current version of a worksheet may print on one page, you may add more 

data in the future that causes the worksheet to extend to multiple pages. It is, 

therefore, a good idea to add a page header to the worksheet that prints in the top 

margin of each page. 

 A header is common content that prints on every page of a worksheet.Landscape 

orientation is a good choice for large worksheets because the printed worksheet’s 

width is greater than its length 

 

Important notes about Formula 
 
 Using constants in formulas: A constant is a value that is not calculated. For example, the date 

10/9/2008, the number 210, and the text "Quarterly Earnings" are all constants. An expression, or 
a value resulting from an expression, is not a constant. If you use constant values in the formula 
instead of references to the cells (for example, =30+70+110), the result changes only if you modify 
the formula yourself. 

 

 Types of operators: There are four different types of calculation operators: arithmetic, 
comparison, text concatenation, and reference.  

 Arithmetic operators: to perform basic mathematical operations such as addition, 

subtraction, or multiplication; combine numbers; and produce numeric results, use the 

following arithmetic operators. 
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Arithmetic operator Meaning Example 

+ (plus sign) Addition 3+3 

– (minus sign) Subtraction  

Negation 

3–1 

–1 

* (asterisk) Multiplication 3*3 

/ (forward slash) Division 3/3 

% (percent sign) Percent  20% 

^ (caret) Exponentiation) 3^2 

 Comparison operators: You can compare two values with the following operators. When two 

values are compared by using these operators, the result is a logical value either TRUE or FALSE  

Comparison operator Meaning  Example 

= (equal sign) Equal to  A1=B1 

> (greater than sign) Greater than  A1>B1 

< (less than sign) Less than  A1<B1 

>= (greater than or equal to sign) Greater than or 

equal to  

A1>=B1 

<= (less than or equal to sign) Less than or 

equal to  

A1<=B1 

<> (not equal to sign) Not equal to A1<>B1 

 Text concatenation operator: Use the ampersand (&) to join, or concatenate, one 

or more text strings to produce a single piece of text. 

Text operator Meaning Example 

& (ampersand) Connects, or concatenates, two values to 
produce one continuous text value  

"North"&"wind" 
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 Reference operators  : Combine ranges of cells for calculations with the 

following operators. 

Reference 
operator Meaning Example 

: (colon) Range operator, which produces one reference 
to all the cells between two references, 
including the two references 

B5:B15 

, (comma) or  

; (semicolon) 

Union operator, which combines multiple 
references into one reference  

SUM(B5:B15,D5:D15) 

SUM(B5:B15;D5:D15) 

(space) Intersection operator, which produces on 
reference to cells common to the two 
references 

B7:D7 C6:C8 

 
  Formulas error  

 
  ##### Error : This error occurs when a column is not wide enough, or a negative date or time 

is used.   

   #DIV/0! Error: This error occurs when a number is divided by zero (0). 

 #N/A error: This error occurs when a value is not available to a function or formula. 

  #NAME? Error : This error occurs when Microsoft Office Excel doesn't recognize text in a 

formula 

  #NULL! Error: This error occurs when you specify an intersection of two areas that do not 

intersect. The intersection operator is a space between references> 

  #NUM! Error: This error occurs with invalid numeric values in a formula or function. 

  #REF! Error: This error occurs when a cell reference is not valid 

 #VALUE! Error: This error occurs when the wrong type of argument or operand is used. 

 
 
 
 
 
 
 
 

javascript:AppendPopup(this,'xldefCellReference_1')
javascript:AppendPopup(this,'IDH_xldefArgument_1')
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Different Examples for Formulas in Excel 
 
Example -1: Convert from hours to minutes 

As a task, time in a timesheet has to be converted from hours minutes. 
 

To convert time to minutes: 
1. In a worksheet, enter your own data or 
the data shown in next Figure  
2. Select cells B4:B8. 
3. Enter the following formula: =A4*24*60. 
4. Press <Ctrl+Enter>. 
 5. Format cells B4:B8 as general by 
selecting the Format menu and choosing 
Cells and General then clicking OK. 

 

 

 

 

Note: To convert minutes to hours and minutes format, usethe formula =b4/24/60. 

Remember to format the cells with a time format, as shown in cell C4 in above Figure 

 
Example-4: Incrementing row numbers 
  Standard row numbering in Excel is often used, but you can also create your own 
numbering system in a table, such as incrementing by 10 as described below. 

 
To increment row numbers by 10: 
1. Select cell A2 and type 0. 
2. Select cell A3 and type the following 
formula: =A2+10. 
3. Select cells A3:A12. 
4. From the Edit menu, select Fill and Down. 

 
 

 

Note: If the value of cell A2 is changed, the values in all other cells change too. 
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Example-5: Combine text and numbers 
In this example, we want to combine text and numbers. Use the & operator to 

accomplish this. 
 

To combine cells containing text and 
numbers: 

1. Select cell B1 and type computers. 
2. Select cell B2 and type 5. 
3. Select cell B4 and type the following 

formula: 
="You ordered"&B2&""&B1&"today!". 

  
 

Note: Each cell reference must be placed between & operators and additional text must be 
surrounded by quotation marks. 

 
 


	 Arithmetic operators: to perform basic mathematical operations such as addition, subtraction, or multiplication; combine numbers; and produce numeric results, use the following arithmetic operators.
	 Comparison operators: You can compare two values with the following operators. When two values are compared by using these operators, the result is a logical value either TRUE or FALSE
	 Reference operators  : Combine ranges of cells for calculations with the following operators.
	  ##### Error : This error occurs when a column is not wide enough, or a negative date or time is used.

